
Experiment 7 
Titration Curves of Strong and Weak Acids and Bases 

 
Goals 

To calibrate a pH probe.  To become familiar with acid-base titration curves.  To determine the 
concentration of an unknown acid. 

 
Equipment and Materials 

0.10 M ammonium hydroxide solution, 0.10 M sodium hydroxide solution, 0.0074 M hydrochloric acid 
solution, 0.0074 M acetic acid solution, a solution of hydrochloric acid with an unknown concentration, 
phenolphthalein solution, magnetic stir plate with magnetic stirrer, 50 mL burettes (2), 100 mL graduated 
cylinder 
 

Discussion 
 
When a base is added to an acid there will be a change in the pH of the solution.  The pH depends on the 
amount of acid, base, and the nature of the acid and the base.  Strong acids and bases have a greater effect 
on pH than weak acids and weak bases at the same concentration.  Examples of acid-base reactions 
include: 
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In this experiment we will look at the titration curves that result from the four reactions written above.  
We will then take advantage of the point of inflection of a titration curve to determine the molarity of a 
sample of hydrochloric acid solution. 
 

Procedure 
 
SAFETY PRECAUTIONS 
Safety glasses are required for this experiment.  Hydrochloric acid can burn skin and should be handled 
with care.  Sodium hydroxide can damage skin and should be handled with care.  The glass electrode is a 
fragile device and should be handled with care.   
 
Students work in pairs throughout this experiment. 
 
 
Part 1  Calibration of pH glass electrode 
1.  The calibration of the pH glass electrode requires the measurement of standard solutions at two 
different pH values.  Pick two buffers to use for the calibration and obtain about 10 mL of each in small 
glass vials.   
 
2.  Connect the LoggerPro data interface and pH glass electrode. 



 
3.  Start the computer application Logger Pro 3.3 and check to see that a pH value is displayed on the 
computer monitor.  If no value is displayed, check all connections and re-start the application. 
 
4.  The glass electrode can be taken from its storage solution and rinsed with distilled or deionized water.  
The glass electrode should never be exposed to air for more than a few seconds. 
 
5.  Place the electrode in the first buffer solution. 
 
6.  Open the Calibrate function of LoggerPro from the Experiment menu.   
 
7.  The window should have Live Calibration selected.  Select Calibrate Now. 
 
8.  Gently stir the buffer solution with the pH probe for 5-10 seconds.  Once the displayed voltage 
stabilizes record the pH of the buffer solution in the window and in the data sheet.  Record the voltage 
reading displayed in the window in the data sheet and select Keep. 
 
9.  Repeat the same procedure for the second standard solution.  The glass electrode should always be 
rinsed with distilled or deionized water when transferring it to a new solution. 
 
Part 2.  Shapes of acid-base titration curves 
Four titration curves will be plotted on the same chart.  By plotting the titration curves together we can 
note the similarities and differences between weak and strong acids and bases.  The shapes of these four 
curves will be compared and contrasted.  In each case the basic solution will be added to the acidic 
solution.  The four titrations are: 
 
sodium hydroxide + hydrochloric acid  ammonium hydroxide + hydrochloric acid 
sodium hydroxide + acetic acid   ammonium hydroxide + acetic acid 
 
1.  Prepare the LoggerPro software to plot data for titration curves.  Use the Data collection option in the 
Experiment menu to set the experiment for an experiment length of 500 seconds and a data sampling rate 
of 0.5 samples per second.   
 
2.  Rescale the y-axis to a pH range of 2-12. 
 
3.  Clean two 50.00 mL burettes using tap water and then distilled or deionized water.   
 
4.  Rinse one of the burettes with a few milliliters of 0.10 M sodium hydroxide solution.  Fill the burette 
to the 0.00 mL mark with the sodium hydroxide solution. 
 
5.  Rinse the second burette with a few milliliters of 0.10 M ammonium hydroxide solution.  Fill the 
burette to the 0.00 mL mark with the ammonium hydroxide solution. 
 
6.  Using a graduated cylinder add 100 mL of 0.0074 M hydrochloric acid solution to a clean and dry 250 
mL beaker.  Add two drops of phenolphthalein indicator to the beaker.  Place a magnetic stir bar to the 
solution and place the beaker onto a magnetic stirrer.  Turn on the stirrer so that the solution is stirred 
without splashing onto the sides of the beaker. 
 
7.  Place the pH probe into the solution and clamp the probe to the ring stand.  The pH should be near 2. 
 



8.  Begin collecting data.  After thirty seconds of data collection, open the valve to the burette and allow a 
constant flow of the basic solution to drop into the acidic solution.  The flow rate should be near one drop 
per second. 
 
9.  Monitor the beaker as the base is added to the acid.  Record the time at which the color of the solution 
changes from clear to a faint pink. 
 
9.  At the end of the 500 second run select Store Latest Run from the Experiment menu.  Label the 
curve using the Text option in the Insert menu. 
 
10.  Repeat the above steps for the three remaining titrations.  Each titration curve should be labeled 
immediately following the titration using text annotation from the Experiment menu. All four titrations 
should appear on the same chart.   
 
11.  Be sure that the chart is titled. 
 
 
Part 3  Quantitative Acid-base Titration 
1.  Obtain and wear eye protection.  You will work in groups as assigned by your instructor. 
 
2.  Use a Pipet Pump and the 25-mL volumetric pipet to add 25.00 mL of the HCl solution into a 250-mL 
beaker.  Enter this volume in the Data and Results Table.  CAUTION: Handle the hydrochloric acid with 
care. It can cause painful burns if it comes in contact with the skin.  
 
3.  Add 100 mL of distilled water to the beaker.  Place a plastic coated magnet in the beaker.  
 
4.  Use a utility clamp to suspend a pH sensor on a ring stand.  Position the pH Sensor in the HCl solution 
and adjust its position at one side of the beaker so that its end is about ¼” above the plastic coated 
magnet. 
 
5.  Use a buret reader to taking volume readings.  Your instructor will show you how to use a buret 
reader. 
 
6.  Rinse the 50-mL buret with a 3–5 milliliters of the ~0.1 M NaOH solution.  Use a buret clamp to 
attach the buret to the ring stand.  Fill the buret a little above the 0.00-mL level of the buret with ~0.1 M 
NaOH solution.  Drain a small amount of NaOH solution into a waste beaker so it fills the buret tip and 
leaves the NaOH at the 0.00-mL level of the buret.  Examine the tip of the buret carefully to be sure that 
there are no air bubbles in it.  If there are, let the NaOH solution drip into the waste beaker as fast as 
possible until you have swept out the bubbles.  Refill the buret and re-adjust the volume to the 0.00-mL 
mark. Record the precise concentration of the NaOH solution in your data table. Dispose of the waste 
solution into the sink.  
 
CAUTION: Sodium hydroxide solution is caustic. Avoid spilling it on your skin or clothing.  
 
7. Prepare the computer for data collection by opening the file in the Experiment 24a folder of 
Chemistry with Computers. The vertical axis has pH scaled from 0 to 14 pH units. The horizontal axis has 
volume scaled from 0 to 25 mL. Check to see that the Meter window shows a pH value between 2 and 3.  
You should rescale the pH axis so it runs from a pH of 1 to a pH of 12, and rescale the volume axis so it 
runs from 0 mL to 40 mL.  
  



Also check to be sure that the pH and the volume can be entered to 2 decimal places, and that the first 
derivative is calculated to 3 decimal places.  In the Data menu select Columns Options and then Volume.  
Set the Displayed Precision to 2 decimal places.  Click OK.  Repeat: Data  Columns Options  pH and 
set the Displayed Precision to 2 decimal places.  Repeat:  Data  Columns Options  d1 and set the 
Displayed Precision to 3 decimal places.  (d1 is the abbreviation for the 1st  derivative, and d2 is the 
abbreviation for the 2nd derivative.)   
 
8. Before adding NaOH titrant, start the magnetic stirrer, click Collect  and monitor  the pH for 5-10 
seconds.  Once the displayed pH reading has stopped changing, click Keep .  In the Events with Entry 
box, type “0.00” (for 0.00-mL added).  Press the ENTER key to store the first data pair for this 
experiment. 
 
9. You are now ready to begin the titration.  This process goes faster if one person manipulates and reads 
the buret while another person operates the computer and enters volumes.   
 
a. Add the first increment of NaOH titrant—enough to raise the pH about 0.2   units.  When the pH 
stabilizes, again click Keep .  In the Events with Entry box, type the current buret volume reading, to the 
nearest 0.01 mL.  Press ENTER.    
 
b. Continue adding NaOH solution in increments that raise the pH by about 0.2 units and enter the buret 
volume reading after each increment. 
  
When a pH value of approximately 3.5 is reached, change to a one-drop increment.  Enter a new 
buret volume reading after each drop is added.  Note:  To get the best-looking titration curve, each 
increment should be the same size—namely one drop. 
 
c.  After a pH value of approximately 10.5 is reached, again add larger increments of NaOH that raise the 
pH by about 0.2 pH units, and enter the buret volume reading after each increment. 
 
d.  Continue adding NaOH solution until you have added about 40 mL of titrant in total. 
 
10.  When you have finished collecting data, click Stop .  Dispose of the beaker   contents into the 
sink. 
 



11.  To delete a “bad” data point, select it and in the Edit menu choose Strike Through Rows. 
A note about the first derivative:  The first derivative gives the value of the slope of the titration curve 
at any point along the curve.  You can see that at the left of the titration curve, the slope is small.  In the 
vertical region of the curve, the slope is large.  And at the right of the curve, the slope is again small.  
That’s why the derivative curve is first small, then has a large spike, and then is small again. 
 
 
  
 
 
 
 
 
 
 
 
 
 
12.  Now you will display the first derivative of the titration curve and the titration curve on the same 
graph.  Click on the pH axis label and check d1 in the dialog box.  Click OK.  The graph will now show 
both the pH curve and the first derivative curve.  Rescale the graph by clicking Autoscale Once in the 
View menu.   
Remove the point protectors by double clicking anywhere on the graph to     make the graph the active 
window.   In the Graph Options box, uncheck Point Protectors to reduce the clutter on the graph.  
Annotate each curve as shown above.  If you wish, save your data to a floppy disk as described in 
Experiment I. 
 
13.  Print as many copies of the Data Table as there are people in your group.   
 
14.  Print the graph in Landscape mode. 
 
Data Analysis  
1. Look at the Table Window. Ignore the column labeled d2.  (This column is the second 
derivative—it has a value of zero at the inflection point.)  In the column labeled d1, find the largest 
number.  The corresponding volume and pH are at the inflection point of the titration curve.  [On your 
graph, notice that the peak of the d1 curve occurs at the inflection point of the titration curve.]  This 
volume is the equivalent volume of NaOH at the equivalence point. 
 
2.  From the volume of NaOH determined in step 1 above, calculate the number of moles of NaOH used. 
 

NaOH NaOHM V = moles NaOH  
 
3.  Refer to the equation for the neutralization reaction given in the introduction.  Determine the number 
of moles of HCl used:  HCl(aq) + NaOH(aq) → H2O(l) + NaCl(aq) 
 
4.  Using the volume of the HCl solution that was pipetted into the beaker, and the number of moles of 
HCl calculated in #3 above, calculate the molarity of the HCl solution. 

HCl
HCl

moles HClM =
V

 

 



 
Data Sheet 

Experiment 7:  Titration Curves of Strong and Weak Acids and Bases 
 
Part 1.  Calibration of pH glass electrode 
 
 
pH of first buffer solution   voltage   
 
pH of second buffer solution   voltage   
 
 
Part 2.  Shapes of acid-base titration curves 
 
Titration  initial pH final pH time of color change  pH at color  
           change 
 
HCl + NaOH             
 
HAc + NaOH            
 
HCl + NH4OH            
 
HAc + NH4OH            
 
 
Part 3.  Quantitative Determination of the Concentration of HCl 

Volume of HCl added to beaker                              mL                               mL  

Concentration of NaOH 
(obtained from your instructor)                             M                             M  

Volume of NaOH added at the equivalence point                             mL                            mL

Moles of NaOH added at the equivalence point                              mol                           mol

Moles of HCl in the beaker                              mol                           mol

Calculated concentration of HCl (reported to 4 
significant figures)                                M                             M

For the instructor’s use only % error = Point deficit = 

 
 



 
Acid Base Indicators 
 
Indicator  pH range  color change  Preparation 
 
methyl violet  0.0 - 1.6  yellow to blue  < 0.1% in water 
crystal violet  0.0 - 1.8  yellow to blue  < 0.1% in water 
malachite green  0.2 - 1.8  yellow to blue-green 0.1% in water 
erythrosine, disodium 2.2 -3.6   orange to red  0.1% in water 
bromophenol blue 3.0 - 4.6  yellow to blue  basic solutions 
congo red  3.0 -5.0   blue to red  0.1% in water 
methyl orange  3.2 -4.4   red to yellow 
ethyl orange  3.4 - 4.8  red to yellow 
ethyl red  4.0 - 5.8  colorless to red 
bromocresol green 4.0 - 5.4  yellow to blue 
alizarin red S  4.6 - 6.0  yellow to red 
methyl red  4.8 - 6.0  red to yellow 
p-nitrophenol  5.4 - 6.6  colorless to yellow 
alizarin   5.6 - 7.2  yellow to red 
   11.0 - 12.4  yellow to red 
brilliant yellow  6.6 - 7.8  yellow to orange 
phenol red  6.6 - 8.0  yellow to red 
cresol red  7.0 - 8.8  red to yellow 
thymol blue  8.0 - 9.6  red to yellow 
phenolphthalein  8.2 - 10.0  colorless to pink 
thymolphthalein 9.4 - 10.6  colorless to blue 
alizarin yellow R 10.1 - 12.0  yellow to red 
2,4,6-trinitrotoluene 11.5 - 13.0  colorless to orange 
 
 
 
 
 


